Getting Started

The Internet Explorer Window

1. Title Bar – displays the name of the current Web page.
2. Internet Explorer Toolbar – contains shortcut buttons for standard Internet Explorer tools.
3. Favorites Buttons – provide access to the Favorites Center where you can work with favorites.
4. Tab Row – displays tabs for open Web pages.
5. Explorer Window – displays the currently active page.
6. Status Bar – displays the link address when you place your mouse pointer over a link and the status of a page as it loads.
7. Instant Search Box – allows you to search for items using your default search provider.
9. Change Zoom Level Button – allows you to change the zoom of the current page.

Opening a Web Page

1. Click in the Address Bar or press Alt + D.
2. Do one of the following:
   • To enter a new address, enter the Internet address for the page and press the Enter key.
   • To use a recently entered address, click the arrow on the Address Bar and select an address from the resulting menu.

Navigating

Use the buttons on the Internet Explorer toolbar to navigate.
• To move back one page, click the Back button.
• To go forward one page, click the Forward button.
• To refresh a page, click the Refresh button.
• To stop a page from loading, click the Stop button.
• To view a recently viewed page, click the Recent Pages button and select the page name from the resulting menu.

Opening a New Window

Click the Page button on the Command Bar and select New Window from the resulting menu, or press Ctrl + N. The currently open page will be displayed in the new window.

Using the Command Bar

The Command Bar contains shortcut buttons for Internet Explorer tools.
• To expand or shrink the Command Bar, drag the separator bar. (If the separator bar is not visible, right-click the Command Bar and select Lock the Toolbars from the resulting menu.)
• To access hidden buttons, click the Expand button on the Command Bar and select the command from the resulting menu.

Tabs

Working with the Tab Row

Internet Explorer 7 has tabbed browsing, which allows you to open multiple pages in a single window. Each open Web page is displayed on a separate tab.
• To open a new tab, click the New Tab button on the Tab Row or press Ctrl + T.
• To switch between open pages, click on a tab.
• To display tabs that will not fit on the Tab Row, click the Previous and Next buttons on the Tab Row. (The Tab Row will display up to ten tabs at one time depending on the size of your window.)
• To close a tab, click the Close Tab button on the tab or press Ctrl + W.

Note: To open a link on a new tab instead of in a new window, hold the Ctrl key and click on the link.

Working with Quick Tabs

Quick Tabs display a thumbnail of each open Web page.
1. Click the Quick Tabs button on the left side of the Tab Row.
2. Optional: To close a page, click the Close Tab button in the upper right corner of the page thumbnail.
3. Do one of the following:
   • To display a page, click on a thumbnail for the page you want to display.
   • To close the Quick Tabs view, click the Quick Tabs button on the left side of the Tab Row.

Note: The Quick Tabs button is only displayed when more than one Web page is open in the window.

Working with the Tab List

The Tab List displays a list of each open Web page.
1. Click the Tab List button on the left side of the Tab Row.
2. Select the page you want to display from the resulting menu.

Note: The Tab List button is only displayed when more than one Web page is open in the window.

Closing a Window with Multiple Tabs

1. Click the Close button in the upper-right corner of the window.
2. Optional: Click the Show Options button in the dialog box that appears and check the boxes to enable options.
3. Click the Close Tabs button.
Favorites

Working with the Favorites Center
Use the Favorites Center to store the addresses of your favorite Web pages.

1. Click the Favorites Center button on the Internet Explorer toolbar or press Ctrl + I. (If Favorites are not displayed, click the View Favorites button at the top of the Favorites Center.)

2. Optional: To anchor the Favorites Center to the Explorer Window, click the Pin the Favorites Center button.

3. Do one of the following:
   • To open a favorites folder, click the folder.
   • To open a favorites page, click the page name.
   • To open a favorites page on a new tab, rest your mouse pointer on the page name and click the arrow next to the page name.
   • To open all of the pages in a favorites folder with each page on a new tab, rest your mouse pointer on the folder name and click the arrow next to the folder.

Note: To unpin the Favorites Center, click the Close the Favorites Center button in the upper-right corner of the Favorites Center.

Adding a Page to Favorites

1. Open the page you want to add to your favorites.
2. Click the Add to Favorites button on the Internet Explorer toolbar.
3. Select Add to Favorites from the resulting menu.
4. Optional: Make changes to the name in the Name box.
5. Click the arrow on the Create in box and select the folder you want to place the page in.
6. Optional: To create a new folder, click the New Folder button and enter a name in the Folder Name box. Click the arrow on the Create in box and select the folder you want to place the new folder in. Click the Create button.
7. Click the Add button.

Note: You can also press Ctrl + D to add a page to your favorites.

Organizing Favorites

1. Click the Add to Favorites button on the Internet Explorer toolbar.
2. Select Organize Favorites from the resulting menu.
3. Do any of the following:
   • To create a new folder, click the New Folder button, enter a name for the folder, and press the Enter key.
   • To move an item, select the item you want to move, click the Move button, select the folder you want to move the selected item to, and click the OK button.
   • To rename an item, select the item you want to rename, click the Rename button, enter a new name, and press the Enter key.
   • To delete an item, select the item you want to delete, press the Delete key, and click the Yes button to confirm deletion.
4. Click the Close button when you are finished.

Importing and Exporting Favorites

1. Click the Add to Favorites button on the Internet Explorer toolbar.
2. Select Import and Export from the resulting menu.
3. Follow the instructions in the Import/Export wizard.
4. Click the Finish button when you are finished.

Saving a Tab Group

1. Open the tabs you want to save as a group.
2. Click the Add to Favorites button on the Internet Explorer toolbar.
3. Select Add Tab Group to Favorites from the resulting menu.
4. Enter a name for the group in the Tab Group Name box.
5. Click the arrow on the Create in box and select the folder you want to store the group in from the resulting menu.
6. Click the Add button to save the group.

Note: To open a saved group of tabs, click the Favorites Center button on the Internet Explorer toolbar. Rest your mouse pointer on the folder name and click the arrow next to the folder.

Search

Using Instant Search
Use Instant Search to search the Internet using your default search provider.

1. Click in the Instant Search box on the Internet Explorer toolbar or press Ctrl + E.
2. Enter a word or phrase in the box.
3. Do one of the following:
   • To display the results, click the Search button on the Internet Explorer toolbar.
   • To display the results in a new page tab, press Alt + Enter.

Note: To use the Address Bar to search, enter “Find,” “Go,” or “?” and a word or phrase in the Address Bar and press the Enter key.

Searching Page Text

1. Click the Search Options button on the Internet Explorer toolbar.
2. Select Find on this Page from the resulting menu.
3. Enter a word or phrase in the Find box.
4. Optional: Select additional options.
5. Click the Next button to find the word or phrase.
6. Click the Close button when you are finished.

Adding Additional Search Providers

1. Click the Search Options button on the Internet Explorer toolbar.
2. Select Find More Providers from the resulting menu.
3. Select the provider you want to add.
4. Optional: Check the Make this my default search provider box.
5. Click the Add Provider button.
6. Optional: Repeat steps 3 through 5 to add additional providers.

Note: To temporarily change the search provider, click the Search Options button and select the provider you want to use from the resulting menu. When you close and restart Internet Explorer, your default search provider will be used.

Changing Search Defaults

1. Click the Search Options button on the Internet Explorer toolbar.
2. Select Change Search Defaults from the resulting menu.
3. Do any of the following:
   • To change the default search provider, select the provider you want to set as the default and click the Set Default button.
   • To remove a provider, select the provider you want to remove and click the Remove button.
4. Click the OK button.
History

Viewing the History
The History displays visited Web pages.
1. Click the Favorites Center button on the Internet Explorer toolbar.
2. Click the View History button at the top of the Favorites Center.
3. Optional: To change the way History items are displayed, click the arrow on the View History button and select an option from the resulting menu.
4. Click on the page name to open the page. (If the pages are organized by date, click on a date heading and click on the page name.)

Searching the History
1. Click the arrow on the View History button.
2. Select Search History from the resulting menu.
3. Enter text in the Search for box and click the Search Now button.

Clearing the History
1. Click the Tools button on the Command Bar.
2. Select Delete Browsing History from the resulting menu.
3. Do one of the following:
   - To delete a specific category, click the Delete button next to the category. Click the Yes button to confirm deletion and click the Close button when you are finished.
   - To delete all browsing history, click the Delete all button and click the Yes button to confirm deletion.

Pages

Zooming on a Page
1. Click the arrow on the Change Zoom Level button at the bottom of the Internet Explorer window.
2. Do one of the following:
   - To zoom in or out, select Zoom In or Zoom Out from the resulting menu.
   - To select a magnification, select a percentage from the resulting menu.
   - To enter a specific magnification, select Custom from the resulting menu, enter a value in the Percentage zoom box, and click the OK button.
Note: To quickly zoom in or out, press Ctrl + “+” or Ctrl + “-”.

Previewing and Printing a Page
1. Click the arrow on the Print button on the Command Bar.
2. Select Print Preview from the resulting menu.
3. Optional: To change the orientation, click the Portrait or Landscape button on the Print Preview toolbar.
4. Optional: To set up the page, click the Page Setup button, select options, and click the OK button.
5. Optional: To change the print size, click the arrow on the Change Print Size box and select a value from the resulting menu.
6. Click the Print Document button on the Print Preview toolbar.
7. Optional: Select print options in the Print dialog box.
8. Click the Print button to print the page.
Note: To print a page with default settings, click the Print button on the Command Bar or press Ctrl + P.

Saving a Page
1. Click the Page button on the Command Bar.
2. Select Save As from the resulting menu.
3. Select a location to save the file.
4. Enter a file name in the File name box.
5. Optional: Click the arrow on the Save as type box and select a file format from the resulting menu.
6. Click the Save button to save the file.

Changing Your Home Page
Your home page is the default page that appears when you launch Internet Explorer and when you open a new window.
1. Go to the page you want to set as your home page.
2. Click the arrow on the Home button on the Command Bar.
3. Select Add or Change Home Page from the resulting menu.
4. Do one of the following:
   - To make the current page your only home page, select Use this webpage as your only home page.
   - To add the current page to your set of home page tabs, select Add this webpage to your home page tabs.
   - To replace your home page or tab set with the currently open page or pages, select Use the current tab set as your home page.
5. Click the Yes button to save the changes.
Note: To remove a home page, click the arrow on the Home button, select Remove, and select the page you want to remove. Click the Yes button to confirm deletion.

RSS Feeds

RSS feeds are frequently updated content published by a Web page. When you go to a Web page that offers RSS feeds, the View feeds on this page button on the Command Bar will turn orange.

Subscribing to a Feed
When you subscribe to a feed, it is added to the Common Feed List. As information is updated, it is automatically downloaded to your computer. Feeds can be viewed in Internet Explorer and other programs, such as an e-mail application.
1. Click the arrow on the View feeds on this page button on the Command Bar.
2. Select the feed you want to subscribe to from the resulting menu.
3. Click the Subscribe to this feed shortcut.
4. Optional: Make changes to the feed name in the Name box.
5. Click the Subscribe button.

Viewing Feeds
Use the Favorites Center to view and refresh feeds that you are subscribed to.
1. Click the Favorites Center button on the Internet Explorer toolbar.
2. Click the View Feeds button at the top of the Favorites Center.
3. Do any of the following:
   - To open a view, click on the feed name.
   - To view feed properties, right-click the feed name and select Properties from the resulting menu. In the Feed Properties dialog box, make changes to options and click the OK button.
   - To refresh a feed, rest your mouse pointer on a feed name and click the Refresh this feed button.
   - To remove a feed, right-click the feed name and select Delete from the resulting menu. Click the Yes button to confirm deletion.
Security

Changing Internet Security Settings
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. Click on the Security tab.
4. Make changes to security zone settings.
5. Click the OK button.
Note: To quickly change Internet security settings, double-click the Internet shortcut on the Status Bar.

Working with the Phishing Filter
The Phishing Filter detects phishing Web sites which capture personal user information. By default, the first time you visit a Web page that is not on your list of legitimate sites, you will be prompted to enable the Phishing Filter to automatically check sites. When the Phishing Filter checks a site, the Phishing Filter icon will appear in the Status Bar.
1. Click the Tools button on the Command Bar.
2. Select Phishing Filter.
3. Do one of the following:
   • To manually check the Web site, select Check This Website from the resulting menu.
   • To turn the Phishing Filter off, select Turn Off Automatic Website Checking from the resulting menu and click the OK button.
   • To report a Web site, select Report This Website from the resulting menu. In the Web page that opens, check the I think this is a phishing website box and click the Submit button.
   • To change Phishing Filter settings, select Phishing Filter Settings from the resulting menu. Select options and click the OK button.
Note: To turn the Phishing Filter back on, click the Tools button on the Command Bar, select Phishing Filter, and select Turn On Automatic Website Checking from the resulting menu. Click the OK button.

Enabling the Content Advisor
The Content Advisor controls the type of content that can be accessed on the Internet.
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. Click on the Content tab.
4. In the Content Advisor section, click the Enable button.
5. Select a category in the list and drag the slider to specify the limit of what users can access.
6. Optional: Repeat step 5 for each category you want to adjust.
7. Click the OK button.
8. Enter a password in the Password box.
9. Reenter the password in the Confirm password box.
10. Enter a hint in the Hint box.
11. Click the OK button.
12. Click the OK button in the dialog box that appears.
13. Click the OK button to close the Internet Options dialog box.

Disabling the Content Advisor
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. Click on the Content tab.
4. In the Content Advisor section, click the Disable button.
5. Enter your password in the Password box and click the OK button.
6. Click the OK button in the dialog box that appears.
7. Click the OK button to close the Internet Options dialog box.

Changing Content Advisor Settings
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. Click on the Content tab.
4. Click the Settings button.
5. Enter your password in the Password box and click the OK button.
6. Select a category in the list and drag the slider to specify the limit of what users can see.
7. Optional: Repeat step 5 for each category you want to adjust.
8. Click the OK button.
9. Click the OK button to close the Internet Options dialog box.

Working with the Information Bar
The Information Bar displays information about security, pop-up windows, ActiveX controls, and other information about the open page. To use the Information Bar, click on the message that appears for more information or to select an option from the resulting menu. To close the Information Bar, click the Close button.

Using the Fix Settings Feature
When your Internet security settings put your computer at risk, the Information Bar will display a warning. To reset your settings to the default Medium-High, click on the message, select Fix Settings for Me from the resulting menu, and click the Fix Settings button.

Working with Pop-up Windows
Pop-up Blocker is turned on by default.
1. Click the Information Bar message that appears when a pop-up is blocked.
2. Do one of the following:
   • To view a pop-up window that has been blocked, select Temporarily Allow Pop-ups from the resulting menu.
   • To always allow pop-ups from the site, select Always Allow Pop-ups from This Site from the resulting menu.

Changing Pop-up Blocker Settings
1. Click the Tools button on the Command Bar.
2. Select Pop-up Blocker.
3. Select Pop-up Blocker Settings from the resulting menu.
4. Optional: To allow pop-ups from a specific site, enter the Internet address in the Address of website to allow box and click the Add button.
5. Optional: Select options in the Notifications and filter level section.
6. Click the Close button.

Turning Off Pop-up Blocker
Note: To turn the pop-up blocker back on, click the Tools button on the Command Bar, select Pop-up Blocker, and select Turn On Pop-up Blocker from the resulting menu.
Add-ons

Managing Add-ons
Add-ons add features such as extra toolbars and stock tickers to your Web browser.
1. Click the Tools button on the Command Bar.
2. Select Manage Add-ons.
3. Select Enable or Disable Add-ons from the resulting menu.
4. Click the arrow on the Show box and select the category of add-ons you want to display from the resulting menu.
5. Select the add-on you want to enable or disable.
6. In the Settings section, do one of the following:
   • To enable the add-on, select Enable.
   • To disable the add-on, select Disable. (Some Web pages may not display properly if an add-on is disabled.)
7. Click the OK button.

Use Internet Explorer Without Add-ons
1. Click the Start button.
2. Select All Programs.
3. Select Accessories.
5. Select Internet Explorer (No Add-ons) from the resulting menu.

Note: Add-ons will be enabled once you close and restart Internet Explorer.

AutoComplete

Changing AutoComplete Settings
AutoComplete retains information you enter on Web pages and automatically fills out Internet addresses, passwords, and information in Web forms. AutoComplete is enabled by default.
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. Click on the Content tab.
4. In the AutoComplete section, click the Settings button.
5. Check or clear the boxes for items you want to enable or disable.
6. Click the OK button.
7. Click the OK button to close the Internet Options dialog box.

Deleting AutoComplete Information
1. Click the Tools button on the Command Bar.
2. Select Internet Options from the resulting menu.
3. In the Browsing history section, click the Delete button.
4. Do any of the following:
   • To delete information from Web forms, click the Delete forms button.
   • To delete passwords, click the Delete passwords button.
   • To delete Internet addresses, click the Delete history button.
5. Click the Yes button.
6. Click the Close button.
7. Click the OK button to close the Internet Options dialog box.

Customizing

Displaying the Menu Bar
The Menu Bar is not displayed by default.
1. Click the Tools button on the Command Bar.
2. Select Menu Bar from the resulting menu.
3. Optional: To hide the Menu Bar, click the Tools button on the Command Bar and select Menu Bar from the resulting menu.

Note: To temporarily display the Menu Bar, press the Alt key.

Displaying a Toolbar
1. Click the Tools button on the Command Bar.
2. Select Toolbars.
3. Select the toolbar you want to display from the resulting menu.
4. To do any of the following:
   • To add a button, select the button in the Available toolbar buttons box and click the Add button.
   • To remove a button, select the button in the Current toolbar buttons box and click the Remove button.
5. Optional: To reorder buttons, select a button in the Current toolbar buttons box and click the Move Up or Move Down button.
6. Optional: To reset the Command Bar, click the Reset button.
7. Click the Close button when you are finished.

Customizing the Command Bar
1. Click the Tools button on the Command Bar.
2. Select Toolbars from the resulting menu.
3. Select Customize from the resulting menu.
4. Do any of the following:
   • To add a button, select the button in the Available toolbar buttons box and click the Add button.
   • To remove a button, select the button in the Current toolbar buttons box and click the Remove button.
5. Optional: To reorder buttons, select a button in the Current toolbar buttons box and click the Move Up or Move Down button.
6. Optional: To reset the Command Bar, click the Reset button.
7. Click the Close button when you are finished.

Links

Using the Links Bar
The Links Bar provides quick access to pages you frequently visit.
1. Click the Tools button on the Command Bar.
2. Select Toolbars and select Links from the resulting menu.
3. Click a shortcut link to open the page.

Adding a Link to the Links Bar
1. Open the page you want to create a link for.
2. Click the Add to Favorites button on the Internet Explorer toolbar.
3. Select Add to Favorites from the resulting menu.
4. Optional: Make changes to the name in the Name box.
5. Click the arrow on the Create in box and select Links from the resulting menu.
6. Click the Add button.

Note: To delete a link, right-click the link on the Links Bar and select Delete from the resulting menu. Click the Yes button.

QUICK Source

Microsoft® Internet Explorer® 7 copyright © 2006 by QUICK Source. All rights reserved. No portion of this material may be saved in any retrieval system without the express written permission of the copyright owner. QUICK Source is not responsible for errors or omissions in this guide or damages resulting from the use of this material.

Microsoft® Internet Explorer® is a registered trademark of Microsoft Corporation. Printed in USA.

Visit our Web site: www.resourcenetwork.com
Shortcuts

Navigating and Viewing Web Pages

Activate a selected link ................................................................. Enter
Add the current page to favorites .............................................. Ctrl + D
Close current tab ................................................................. Ctrl + W
Copy selected item to the clipboard ........................................ Ctrl + C
Display Help .............................................................................. F1
Find on the current page .............................................................. Ctrl + F
Go to your home page ................................................................. Alt + Home
Go to the next page ................................................................. Alt + →
Go to the previous page ......................................................... Alt + ←
Move forward through items .................................................. Tab
Move backward through items ............................................... Shift + Tab
Move to the beginning of a document ......................................... Home
Move to the end of a document ................................................... End
Open a new tab ................................................................. Ctrl + T
Open a new window ................................................................. Ctrl + N
Open a new Web page .............................................................. Ctrl + O
Open Quick Tabs ...................................................................... Ctrl + Q
Paste copied item at the selected location ................................ Ctrl + V
Print the current page_ACTIVE_tab ____________________________ Ctrl + P
Refresh the current page ........................................................... F5
Save the current page ................................................................. Ctrl + S
Scroll up ................................................................................. ↑
Scroll down .............................................................................. ↓
Scroll up in large increments .................................................. Page Up
Scroll down in large increments .............................................. Page Down
Select all items on the current page ...................................... Ctrl + A
Stop downloading a page ........................................................ Esc
Switch between tabs ................................................................. Ctrl + Tab
Toggle between full screen and regular views ................................ F11
Zoom to 100% ..................................................................... Ctrl + 0 (zero)

Using the Command Bar

Open the Help button menu .............................................................. Alt + L
Open the Home button menu ......................................................... Alt + M
Open the Page button menu ......................................................... Alt + P
Open the Print button menu ......................................................... Alt + R
Open the Tools button menu ......................................................... Alt + O
Open the RSS button menu .......................................................... Alt + J

Using the Menu Bar

Display the Menu Bar ................................................................ Alt
Open the Edit menu ................................................................. Alt + E
Open the Favorites menu .......................................................... Alt + A
Open the File menu ................................................................. Alt + F
Open the Help menu ................................................................. Alt + H
Open the View menu ................................................................. Alt + V
Open the Tools menu ................................................................. Alt + T

Using the Address Bar

Add "www" and ".com" to text in the Address Bar ................................. Ctrl + Enter
Display a list of addresses you have entered ........................................ F4
Move forward through AutoComplete list ........................................... ↑
Move backward through AutoComplete list ........................................... ↓
Move to the next section of the Web page address ......................... Ctrl + →
Move to the previous section of the Web page address ................ Ctrl + ←
Select text in the Address Bar ...................................................... Alt + D

Using the Favorites Center

Open Add to Favorites menu ......................................................... Alt + Z
Open Favorites ......................................................................... Ctrl + I
Open Favorites Center ............................................................... Alt + C
Open Feeds .............................................................................. Ctrl + J
Open History ............................................................................ Ctrl + H

Getting Help

Accessing Internet Explorer Help

1. Click the Help button on the Command Bar. (If the Help button is hidden, click the Expand button and select Help.)
2. Select Contents and Index from the resulting menu.
3. Optional: Click the Back and Forward buttons on the Help toolbar to navigate viewed pages.
4. Optional: Click the Hide or Show button on the Help toolbar to hide or display Help tabs.
5. Click the Close button to close Internet Explorer Help. Note: You can also press F1 to access Help.

Using the Help Contents

1. Open Help and click on the Contents tab.
2. Click the book icon to expand a Help heading.
3. Click on a topic to view Help information.

Printing a Help Topic

1. Open the topic you want to print.
2. Click the Options button on the Help toolbar.
3. Select Print from the resulting menu. (If a dialog box appears, specify whether you want to print the selected topic or the selected heading and all subtopics.)
4. Optional: Select print options in the Print dialog box.
5. Click the Print button to print the topic.

Using the Help Index

1. Open Help and click on the Index tab.
2. Enter a word or phrase in the Type in the keyword to find box.
3. Select the topic you want to view and click the Display button.

Using the Help Search

1. Open Help and click on the Search tab.
2. Enter a word or phrase in the Type in the keyword to find box.
3. Click the List Topics button.
4. Select the topic you want to view and click the Display button.

Saving a Favorite Help Topic

1. Open the topic you want to save.
2. Click on the Favorites tab.
3. Click the Add button.
Note: To open a favorite topic, click on the Favorites tab, click on the topic, and click the Display button.

Getting Web Help

For additional Help, click the Web Help button on the Help toolbar and click the Support Online shortcut. You can also click the Help button on the Command Bar and select Online Support from the resulting menu.